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CHAPTER 1.  INTRODUCTION 

 

SYSTEM OVERVIEW 

The Utility Accommodation and Conflict Tracker (UACT) system is a web-based prototype for 
the management and tracking of utility conflicts.  Key functionalities of UACT include: 
 

• Utility Conflict Tracking.  Department of Transportation (DOT) officials can enter 
utility conflict data based on existing utility facility data and create visual representations 
of utility conflicts using a mapping component.  The prototype also provides an overview 
of the status of utility conflicts for each project. 

 
• Utility Agreement Development and Tracking.  A utility company can complete the 

required forms of a utility agreement online and file the document electronically for 
review by the appropriate district and division personnel.  The system guides the user 
through the completion process and selects appropriate forms based on the specific 
circumstances of the utility conflict. 

 
• Document Upload and Conversion to portable document format (PDF).  The 

prototype allows users to upload documents that are accessible to other users based on 
roles and privileges.  The prototype converts all documents automatically to PDF to allow 
easy access to all privileged users. 

 
• Design and Construction Information System (DCIS) Project Data Access.  The 

researchers designed the prototype to connect to DCIS and display project data that are 
collected in a DCIS data warehouse. 

 
• Utility Facility Database Access.  The researchers designed the prototype to integrate 

with a Geographic Information System (GIS) based database of utility facility features. 
 

• Sophisticated User Access Model.  UACT provides a sophisticated and flexible access 
system based on capabilities, roles, and privileges.  UACT administrators can further 
customize access to UACT by providing individual users access to specific projects. 

 
This manual describes the process to install and configure UACT.  The document is divided into 
chapters as follows: 

 
• Chapter 1 is this introductory chapter. 

 
• Chapter 2 describes UACT system requirements. 

 
• Chapter 3 describes the steps to install and configure required and recommended UACT 

software components. 
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• Chapter 4 describes the steps to copy data to a tablespace in Oracle and verify UACT is 
working properly. 

 
• Chapter 5 describes procedures to test and verify the correct installation of all UACT 

system components. 
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CHAPTER 2.  UACT SYSTEM REQUIREMENTS 

 

SYSTEM ARCHITECTURE 

UACT is a system that consists of several components that researchers designed to manage 
utility conflict data using web-based access.  As Figure 1 shows, UACT has two main groups of 
components: client-side components and server side components. 
 

 

Figure 1.  System Architecture. 

 
On the client side, a web browser serves as a front-end interface that allows users on client 
computers to interact with the UACT system to complete the utility adjustment process.  Both 
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utility company users and TxDOT users can act as clients, but their interfaces are different and 
have different access levels.  To access UACT, users must have a computer that meets the 
following minimum system requirements: 
 

• desktop or laptop computer running Windows® XP with Service Pack 2 (SP2), 
• Microsoft® Internet Explorer® 6.0 with SP2 or higher, 
• portable document format (PDF) reader such as Adobe® Acrobat Reader® 7.0, 
• internet connection, 
• email account, and 
• UACT active account. 

 
On the server side, UACT includes a number of system components, including the following: 
 

• Web server.  Microsoft Internet Information Services® (IIS) 6.0 running on Windows 
Server 2003®. 

 
• Map server.  Environmental Systems Research Institute (ESRI®) Arc Geographical 

Information System Server™ (ArcGIS™ Server) Version 9.2. 
 

• Spatial data engine.  ArcGIS Server can be configured to access spatial data in formats 
such as ESRI shape file format, personal geodatabases (.mdb file format), or 
geodatabases using ESRI’s Arc Spatial Data Engine® (ArcSDE®).  

 
• File upload component.  UACT currently uses a file upload component of ASP.NET™.  

UACT could use another upload component such as SoftArtisans® FileUp™. 
 

• PDF generator.  Adlib Software® Adlib Express Server® with Compressor Add-On.  
This standalone server application monitors the contents of a specific input folder at 
regular time intervals.  In UACT, the application checks the contents of a designated 
input folder every five seconds.  If Adlib Express Server detects a new file in that folder 
(typically if a utility company or TxDOT user has uploaded a file to the server), Adlib 
Express Server generates a PDF file and stores that file in a designated output folder.  In 
order for Adlib Express Server to convert a file to PDF, an application that can open the 
file must be installed on the server.  

 
• Microsoft Office® (Word®, Excel®, PowerPoint®, and Visio®).  Adlib Express Server 

supports a number of native applications installed on the server, including Microsoft 
Office.  In the current TTI implementation, UACT recognizes Word, Excel, PowerPoint, 
and Visio files, allowing Adlib Express Server to generate PDF versions of Word (.doc) 
files, Excel (.xls) files, PowerPoint (.ppt) files, and Visio (.vsd) files. 

 
• Additional PDF file generation support.  Cimmetry® AutoVue® 2D Desktop (now 

Oracle® AutoVue) enables Adlib Express Server to generate PDF versions of additional 
file types, in particular MicroStation® (.dgn) and AutoCAD® (.dwg). 
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• Microsoft .NET™ 2.0 framework.  An integral Windows component required to run 
applications developed with .NET technology.  The version used for the implementation 
of UACT is 2.0. 

 
• Oracle Client.  In order for the IIS web server to communicate with the Oracle database 

server and retrieve data, it requires a data provider that supports Oracle.  The UACT 
implementation at TTI uses the .NET Managed Provider for Oracle from Microsoft, 
which is part of the .NET 2.0 framework. 

 
As Figure 1 shows, the UACT implementation uses two server side environments: a database 
server (that includes Oracle and ArcSDE) and a web server (that includes all other components 
in addition to the UACT code).  The web server also stores all files uploaded to the system as 
well as data files UACT generates during the utility adjustment process.  A UACT 
implementation at TxDOT will likely involve separate mapping and data storage servers.  In 
addition, TxDOT would connect UACT to an existing email server to allow for system-generated 
email notifications. 
 

SPACE REQUIREMENTS 

Client Side Space Requirements 

On client computers, requirements are minimal.  Other than the applications listed previously 
(i.e., an internet browser, PDF viewer, and an email client), users do not need to install additional 
components.  During the submission of utility agreement applications to TxDOT, users need to 
have access to files they need to upload to the server.  Currently, there is no limit on the number 
of files or file size a user can upload to UACT.  In an implementation of the prototype, TxDOT 
should consider a suitable limit for both file size and number.  For example, the limit on the file 
size a user can upload could be stored as a parameter in a configuration file to facilitate 
modifications and fine-tuning of the maximum file size on an as-needed basis.  The following 
sections describe requirements on the server side. 
 

Server Side Space Requirements 

On the server side, the prototype consists of two servers: a database server, and a web server.  
The database server uses an implementation of Oracle 10g that consists of several tablespaces.  
For each tablespace, the researchers created a database schema for the creation of tables, 
relationships, and indexes.  UACT consists of the following tablespaces: 
 

• UACT.  This tablespace includes the tables of the subject areas Feature, Utility Conflict, 
Utility Agreement Assembly, Permissions, Project, Document, Meeting, User, and 
System. 

 
• DCIS.  This tablespace includes the DCIS Subject Area table. 

 



 6

• UFD.  This tablespace includes the tables of the UFD (Utility Facility Database) Subject 
Area. 

 
• SDE.  This tablespace includes the tables of the ArcSDE Subject Area.  Note that the 

researchers implemented some of the tables of the subtype GAIP (GIS Architecture 
Infrastructure Project) Feature, including Asset Features and Geopolitical Features as 
ESRI ArcSDE tables in the SDE Oracle tablespace. 

 
These tablespaces provide the core functionality of the UACT system.  During development, the 
research team created two copies of the UACT tablespace to test changes to the prototype while 
keeping one version ready for user testing at all times.  In addition, the researchers created four 
additional tablespaces to represent existing/external systems during prototype development.  The 
purpose of the additional tablespaces was to test the ability of the UACT prototype to connect to 
these systems.  During implementation, existing TxDOT systems would replace the following 
tablespaces: 
 

• FileNet.  This tablespace includes the tables of the FileNet Subject Area. 
 
• MainStreet.  This tablespace includes the tables of the MainStreet Texas Subject Area. 

 
• ROWIS.  This tablespace includes the tables of the ROWIS (Right of Way Information 

System) Subject Area. 
 

• UIRPRO.  This tablespace includes the tables of the UIR (Utility Installation Review) 
Subject Area. 

 
The TTI implementation allocates 100 megabytes for the UACT tablespace.  The space actually 
occupied in the tablespace is currently about 20 megabytes.  However, it is possible that a UACT 
implementation will need additional indexes to increase database query performance, which 
would require additional space in Oracle. 
 
During prototype development, the TTI implementation allocated 20-30 megabytes each for the 
tablespaces DCIS, UFD, and SDE.  This space requirement was sufficient during database 
testing.  In a production version, these tablespaces may require additional space in Oracle.  For 
more information, please refer to the Oracle configuration section in Chapter 4. 
 

Secondary Storage Requirements 

In addition to the Oracle database space, UACT requires a secondary storage mainly for files that 
users upload and PDF conversion of those files.  Based on a sample of utility agreement 
applications submitted during preliminary testing, the approximate file space requirements for 
secondary storage per utility agreement including file attachments are as follows: 
 
 
 
 

Minimum: 5 megabytes 
Maximum: 50 megabytes 
Average: 25 megabytes 
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As a conservative estimate, a utility agreement application could require about 25-50 megabytes 
of space.  For a total of 250 utility agreements per year throughout the state, the total annual 
secondary storage requirement would be between 6.3 and 12.5 gigabytes of space per year.  
Although the researchers assume that utility agreements will have the greatest storage 
requirements, there are additional files that users can upload through UACT.  At this point, the 
researchers estimate an annual secondary storage requirement of no greater than 15 gigabytes. 
 

MAPPING COMPONENT REQUIREMENTS 

The mapping component has the following two main functions: 
 

• display geographic data of a project and utility features to help locate utility conflicts, and 
 
• allow users to outline utility conflicts using an interactive tool and associate the utility 

conflict outline with the utility conflict. 
 
The current implementation of the mapping component includes a number of GIS data layers, 
which the researchers grouped into the following essential and recommended data layers: 
 

• Essential GIS data layers.  UACT must have the following data layers in order to 
function properly: 

 
o Alignments (source: project 0-5475 (1)), 
o Utility Features (source: project 5-2110-01 (2)), 
o Right of way features (source: project 0-5475 (1)), and 
o City Street Layer (source: ESRI) or TxDOT Route Layer (source: TxDOT 

Technology Services Division (TSD)). 
 

• Recommended data layers.  These layers are not critical but would be useful to UACT 
users.  This includes mainly TxDOT data layers in the format of ESRI shape file, 
personal geodatabase, or ArcSDE format such as: 

 
o TxDOT County Layer (source: TxDOT TSD), 
o TxDOT Control Section 2005 (source: TxDOT TSD), 
o TxDOT District Layer (source: TxDOT TSD), 
o TxDOT Route Marker (source: TxDOT TSD), 
o TxDOT Route Layer (source: TxDOT TSD), 
o City Street Layer (source: ESRI), and 
o Aerial photography (source for current implementation: TxDOT Houston District, 

stored in MrSid format). 
 
In ESRI shape format, the vector layers (routes, control sections, and so on) require about 
500 megabytes of space.  UACT uses the county layer in combination with the aerial 
photography as a convenient tool to help UACT users visually find the location of a utility 
conflict.  However, UACT does not read any data from these layers.   
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In the case of the Houston aerial photography layer, the spatial resolution is 6 inches.  This layer 
provides aerial photography for a section of IH-10 that covers the extent of the Katy Freeway 
Project.  Users have found that layer very useful because of the quality of information that 
high-resolution aerial photography can provide.  By comparison, one-meter resolution aerial 
photography – which is available through the Texas Natural Resource Information System 
(TNRIS) – does not provide adequate resolution to identify features on the ground and is now 
more than 10 years old.  The aerial photography files take up about 210 megabytes of space.  For 
an implementation, it would be advisable to include aerial photography for the entire 
implementation district, which may require additional storage space.  For example, background 
imagery for Bexar County in San Antonio that the researchers used for a different project at 
similar resolution ranged between 10 and 25 gigabytes.   
 
It is not critical to have aerial photography as a layer on the UACT mapping component because 
UACT does not read data from aerial photography.  If no aerial photography is available, the 
implementation should provide a street network layer to help locate utility facilities.  Any city 
street layer TxDOT may already have would be adequate, e.g., the TNRIS StratMap 
transportation data layer (Phase II), which TNRIS published in December 2006.  This dataset is 
currently available at the county level.  
 
If aerial photography is available, it can be quite useful.  In the long term, it is possible the entire 
state will have high-resolution aerial photography.  In the short term, high-resolution aerial 
photography is only available at certain locations, primarily major urban areas.  Conversations 
with district officials suggest the level of availability of high-resolution aerial photography is 
increasing, but it is not clear what the current trend is.  A preliminary estimate based on the file 
size associated with the 6-inch aerial photography dataset for Bexar County suggests the entire 
state could require some 2.2 – 2.4 terabytes of space.  In either case, the UACT prototype is 
prepared to accommodate and display any georeferenced aerial photography data that will 
become available over the next years. 
 

RETENTION REQUIREMENTS 

Currently, TxDOT keeps paper copies of utility agreement assemblies for a certain period of 
time, at which point the joint-use acknowledgement attachment is detached and moved to a 
permanent file.  The joint-use acknowledgement serves as a means to provide supporting 
documentation for the (lack of) property interest by utility companies on the land they occupy 
within the state right of way.  Similarly, a joint-use acknowledgement can be used to document 
the right of TxDOT facilities to occupy a property interest held by a utility company, including 
fee and easements.  The researchers designed the prototype to facilitate and standardize the 
creation of utility agreement assemblies for reimbursable utility adjustments.  However, the 
prototype does not include a function to sign the agreement digitally, which would be an option 
for the implementation version.  During discussion with TxDOT officials, there was a consensus 
to start using UACT as a means to facilitate approval of utility agreement assemblies by 
providing a preview of the documentation to districts and the Right of Way (ROW) Division.  As 
such, TxDOT would lock the assembly for editing by the utility company until a district or the 
ROW Division has reviewed the assembly.  If district and ROW Division approved the 
assembly, it would be unlocked for printing only and the utility company could print, sign, and 
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then send the assembly to TxDOT for official approval.  If both TxDOT and utility companies 
agree, a digital signature on the utility agreement assembly could replace the need for printing 
and sending the signed paper copies to TxDOT.  Thus, until the prototype implements digital 
signatures, retention requirements would not apply to UACT. 
 
The current UACT implementation at TTI does not make a distinction between active utility 
agreement applications and archived utility agreement applications in terms of database record or 
associated file locations.  The only difference between active and archived agreements is a status 
value in the database that changes from “active” to “completed” whenever the agreement has 
completed the entire application process.  The system uses the distinction between active and 
archived utility agreements for the purpose of generating lists, running queries, and generating 
reports. 
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CHAPTER 3.  COMPLETE SOFTWARE COMPONENT INSTALLATION 
AND CONFIGURATION 

 

INTRODUCTION 

This chapter describes the steps to install and configure all software components UACT needs, 
assuming a new and complete installation process; i.e., no software components were previously 
installed on the web server.  If some of the software components have been previously installed, 
it may be necessary to adjust the installation and configuration procedure accordingly.  However, 
the instructions assume the configuration and installation of an Oracle database management 
system version 10g release 2.  In addition, the instructions assume that ESRI ArcSDE version 9.2 
has been installed on the database server. 
 
Unless otherwise indicated, this chapter assumes the following sequence for installing and 
configuring software components: 
 

1. Folder structure creation and data copying. 
 
2. Microsoft Internet Information Services (IIS) installation. 
 
3. Microsoft Office installation. 
 
4. Oracle 9i client installation. 
 
5. Cimmetry AutoVue 2D Desktop Edition v19.2c2 installation. 
 
6. Microsoft .NET 2.0 framework installation. 
 
7. Adlib Express Server 3.8.2 installation. 
 
8. ESRI ArcGIS Server v9.2 installation. 
 
9. UACT mapping component configuration. 
 
10. Microsoft IIS final configuration. 
 
11. ESRI ArcSDE configuration. 

 
The software versions listed above are those used for developing and testing UACT.  Installation 
and configuration steps might vary if using newer software versions.  TxDOT should review the 
corresponding instructions even if a software component is already installed on the TxDOT web 
server, because UACT may require a need for changes in the software component’s 
configuration settings.  
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Names Used in UACT 

Throughout the application, the system uses specific names to designate elements such as 
services, which are necessary for proper communication among components.  The system uses 
the following names: 
 

• Website.  UACT is the web site name as well as the name of the physical folder that 
stores the UACT source code. 

 
• ArcGIS Server.  UACT_MapService is the name of the service used by ArcGIS Server, 

and UACT_MapApp is the name of the application used by ArcGIS Server. 
 

• Oracle.  UACT is the name of the Oracle tablespace, and UACT_USER is the username 
of the account that UACT uses to access the Oracle database (see Configuration of the 
Oracle Database in chapter 4). 

 

FOLDER STRUCTURE AND DATA COPYING 

This manual assumes the letter prefix “D:\” represents the drive on the web server that serves as 
the repository for UACT folders.  Make the corresponding changes in the following instructions 
if the letter prefix for the installation drive is different.  The current UACT implementation uses 
the following folder structure on the web server to store UACT files (Figure 2): 
 

• Data.  This folder contains the Oracle export files that include database schemas with 
most database objects such as tables, views, functions, synonyms, and data.  UACT will 
need these files during configuration of the Oracle database (see chapter 4). 

 
• FILE_UPLOAD.  Adlib Express uses this folder to convert uploaded UACT documents 

to PDF. 
 
• Software.  This folder contains several subfolders with installation files for software 

components that need to be installed separately. 
 
• UACT.  This is the main folder, which includes many subfolders containing all UACT 

related code and data (except GIS data).  GIS is a subfolder that contains all GIS vector 
data. 

 
• Website.  This folder contains a subfolder called UACT_MapApp, which contains the 

code of the GIS map application used by UACT.   
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Figure 2.  UACT Folder Structure. 

 
Use the following procedure to copy the UACT source code and current UACT user files to the 
web server: 
 

1. Copy the UACT folder (contains the UACT system code) from the UACT Digital 
Versatile Disk (DVD) to the D: drive on the web server.  

 
2. Unzip all the zipped files in the UACT folder, and place the result in folder D:\UACT. 
 
3. Edit file “SystemParam.cs” (located at D:\UACT\App_Code\Library\) as follows: 

 
o replace 

 
_appUrl = “http://impdev.tamu.edu/UACT”  
 

with TxDOT’s web address of the UACT system: 
 
_appUrl = “http://<TxDOT web address of the UACT system>/UACT/” 

 
o replace 
 

dbConnectionString = “Data Source=ORAGIM;UID=UACT_USER;PWD=456789;”  
 

with TxDOT’s connection string; and 
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o search for D:\ in the file and replace with the actual installation drive letter where 
the UACT system will be installed if other than D:\. 

 
4. Copy the FILE_UPLOAD folder from the UACT DVD to the D: drive on the web server. 

 
5. Create a Website folder on the D: drive on the web server. 

 

MICROSOFT IIS INSTALLATION AND INITIAL CONFIGURATION 

This section summarizes the steps to install Microsoft IIS and to create a web site for UACT.  
Use the following procedure to install Microsoft IIS: 
 

1. Under Start > Control Panel > Add/Remove Programs, click “Add/Remove Windows 
Components.”  

 
2. Select Internet Information Services and proceed with the installation process.  

 
3. Open the IIS Manager to verify the IIS installation (Figure 3):  

 
4. In the left panel, navigate the folder tree under the machine name to find “Web Sites.”  

The web server host listed should be “Default Web Site.” 
 

5. Open Internet Explorer and enter “http://<machine name>” (where <machine name> is 
the server name).  The browser should return either an “Under Construction” page or a 
“Microsoft IIS Help” page. 
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Figure 3.  IIS Manger Default Web Site. 

 
The next step is to create a new web site for UACT on the web server.  If the web server is a 
dedicated server to host UACT, there is no need to create a new web site for UACT.  It is only 
necessary to rename the default web site as “UACT.”  Note: The name of the UACT web site is 
“UACT.”  As discussed later in the chapter, the physical address of the UACT folder on the web 
server is also “UACT.”  For the configuration of this web site, see section IIS Final 
Configuration toward the end of this chapter.   
 
If the web server is a dedicated server to host UACT, use the following procedure to rename the 
IIS default web site: 
 

• In IIS Manager, navigate the folder tree under the machine name to find “Web Sites.”   
 

• Right-click “Default Web Site” and rename the web site as “UACT.” 
 
If the web server will host multiple web sites sharing the same Internet Protocol (IP) address, it is 
necessary to create a virtual directory within IIS to host UACT.  Use the following procedure to 
create this virtual directory: 
 

• In IIS Manager, navigate the folder tree under the machine name to find “Web Sites.” 
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• Right-click “Default Web Site” and select New > Virtual Directory.  The Virtual 
Directory Creation wizard starts.  In the Virtual Directory Alias window, type “UACT” 
and click “Next” (Figure 4). 

 

  

Figure 4.  Virtual Directory Creation Wizard Virtual Directory Alias Window. 

 



 17

• In the Web Site Content Directory window, enter the path or browse to the D:\UACT 
folder (Figure 5) and Click “Next.” 

 

  

Figure 5.  Virtual Directory Creation Wizard Web Site Content Directory Window. 
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• In the Virtual Directory Access Permissions window, select the Read option (Figure 6).  
Click “Next” to complete the virtual folder creation wizard. 

 

 

Figure 6.  Virtual Directory Creation Wizard Access Permissions Window. 

 

MICROSOFT OFFICE INSTALLATION 

Microsoft Office must be installed on the web server to allow conversion of Microsoft Office 
documents to PDF using Adlib Express Server 3.8.2.  For simplicity, this section does not 
include instructions for installing Microsoft Office under the assumption that TxDOT has 
standardized procedures for installing and configuring Office applications.  A standard 
installation of the software is sufficient.  At the very least, install Word, Excel, PowerPoint, and 
Visio.   
 

ORACLE CLIENT INSTALLATION 

UACT uses open database connectivity (ODBC) to communicate with the Oracle database.  This 
process requires the installation of Oracle Client on the web server (unless Oracle is installed on 
the same machine as the web server).  For more information, refer to the following references: 
 

• Oracle 9i Client Installation Guide (3) and 
 

• Oracle Enterprise Manager Configuration Guide (4). 
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This section assumes the following parameters associated with a hypothetical Oracle database 
(change parameters according to the actual Oracle database implementation used):  
 

Service name:  SNHYP 
Host name:  HYP-ORACLE 
Net service name: SNHYP 
Protocol type:   Transmission Control Protocol (TCP) 
Port type:  1521 

 
It is necessary to install a version of Oracle Client that is compatible with the version of Oracle 
installed on the server.  The UACT implementation at TTI uses an Oracle 10g Release 2 
(10.2.0.1.0) database.  The version of Oracle Client installed at TTI was 9i, which is compatible 
with Microsoft .NET framework 2.0 and the Oracle 10g database.  Use the following procedure 
to install Oracle 9i Client on the web server: 
 

• Insert the Oracle 9i client CD and run the installation setup.exe file.  When you get to the 
File Locations screen, create/select an appropriate Oracle Home name and folder path 
and click “Next” (Figure 7).  Hint: Use the default name and path. 

 

 

Figure 7.  Oracle Client File Locations Window. 
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• On the Installation Types screen, select Runtime and click “Next” (Figure 8). 
 

 

Figure 8.  Oracle Client Installation Types Window. 
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• The Summary screen lists the components to install (Figure 9).  Click “Install” to 
continue.  The installation may take a few minutes to complete.  

 

 

Figure 9.  Oracle Client Installation Summary Window. 
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• After completing the installation of the components, the Configuration Tools screen 
appears (Figure 10).  After the system starts the tool and the “Next” button becomes 
enabled, click “Next” to set up or enable a net service name using the Oracle Net 
Configuration Assistant. 

 

 

Figure 10.  Oracle Client Configuration Tools Window. 
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• Select No, I will create net service names myself to create a new net service name and 
click “Next” to continue (Figure 11). 

 

 

Figure 11.  Oracle Net Configuration Assistant Welcome Window. 

 
• Select Oracle 8i or later database or service and click “Next” (Figure 12). 

 

 

Figure 12.  Oracle Net Configuration Assistant Database Version Selection Window. 
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• Enter the service name associated with the database (assumed to be “SNHYP”) and click 

“Next” (Figure 13). 
 

 

Figure 13.  Oracle Net Configuration Assistant Service Name Window. 

 
• Select TCP as the network communication protocol and click “Next” (Figure 14). 

 

 

Figure 14.  Oracle Net Configuration Assistant Network Protocol Window. 
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• Enter the database computer’s host name (this example assumes HYP-ORACLE), select 

the port number (this example assumes the default 1521), and click “Next” (Figure 15). 
 

 

Figure 15.  Oracle Net Configuration Assistant Host Name and Port Number Window. 
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• Select Yes, perform a test to perform a database connection test (Figure 16) and click 
“Next.” 

 

 

Figure 16.  Oracle Net Configuration Assistant Connection Test Window. 
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• Enter the net service name (Figure 17).  By default, the Oracle Net Configuration 
Assistant assumes the net service name is the same as the service name provided earlier 
(Figure 13).  When finished, click “Next” to continue, and then exit the installer. 

 

 

Figure 17.  Oracle Net Configuration Assistant Net Service Name Window. 

 

CIMMETRY AUTOVUE 2D DESKTOP INSTALLATION 

Cimmetry AutoVue 2D Desktop enables PDF creation using Adlib Express for file types without 
a corresponding native software installation on the server.  For example, AutoVue enables Adlib 
Express to convert MicroStation .dgn files and AutoCAD .dwg files to PDF without an 
installation of MicroStation or AutoCAD on the server.  For more information, refer to the 
following reference: 
 

• AutoVue Desktop Edition Installation and Administration Manual (5). 
 
Installing Cimmetry AutoVue 2D Desktop v19.2 is straightforward.  To install the software on 
the web server, use the following procedure: 
 

• Navigate to the folder SOFTWARE\Cimmetry_AutoVue\av19.2\win32\ on the UACT 
DVD.  Double-click “avsetup.exe” to start installation.  Note: Running this setup file 
(which for convenience the researchers downloaded from the vendor’s web site to the 
UACT DVD) will install an evaluation version of the software.  For a full 
implementation of UACT, TSD will need to acquire a license directly from the software 
vendor. 

 
• Select the default destination folder and follow the installation instructions. 
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It is necessary to configure the pen settings in AutoVue to make sure that the PDF files that 
Adlib Express Server generates are readable.  During preliminary testing, the researchers found 
that in general, the best results with the current versions of AutoVue and Adlib Express involve 
the use of thin line pen settings.  Use the following procedure to configure pen settings: 
 

• Load AutoVue and open a Computer Aided Design (CAD) file, e.g., a MicroStation .dgn 
file or an AutoCAD .dwg file. 

 
• From the File menu select Print.  In the Print Properties window, select the Pen Settings 

tab (Figure 18). 
 

 

Figure 18.  AutoVue Pen Settings Window. 
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• Under Current Pen Settings, select default.c2t from the list of current pen settings (Figure 
19). 

 

 

Figure 19.  AutoVue Customized Pen Settings Window. 

 
• Under From/To, select all entries by clicking on the first entry, then shift-click the last 

entry.  Under Change/Thickness, set all line weights to 0.01 inch (0.254 mm) and click 
“OK.”  

 

MICROSOFT .NET 2.0 FRAMEWORK INSTALLATION 

The programming interface of UACT uses the Microsoft .NET 2.0 framework.  For UACT to 
function properly on the web server, users must install the .NET 2.0 framework.  Note that only 
users with administrative privileges can install the .NET 2.0 framework.  Use the following 
procedure to install Microsoft .NET 2.0 on the web server: 
 

• Navigate to the folder SOFTWARE\Microsoft_NET\ on the UACT DVD, run file 
“dotnetfx.exe,” and follow the installation instructions.  Microsoft provides the .NET 
framework free of charge and hence the installation does not require an additional 
license. 
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ADLIB EXPRESS SERVER INSTALLATION 

To facilitate the creation of PDF versions of user-uploaded files and system-generated forms, 
install and configure Adlib Express Server on the web server.  Note that only users with an 
administrator privilege on the server can install and/or change Adlib Express Server options.  For 
more information, refer to the following reference: 
 

• Express User Guide Version 3.8 (6) 
 
Note: To install and/or configure Adlib Express, make sure to connect to the server using the 
Console mode.  If you use a remote desktop connection, make sure to use the mstsc/console 
command.  Use the following procedure to install Adlib Express Server 3.8.2 on the web server: 
 

1. Make sure Microsoft .NET Framework 2.0 is installed on the server prior to installing 
Adlib Express Server. 

 
2. Navigate to the folder SOFTWARE\Adlib_Express\ on the UACT DVD, run file 

“ExpressServer382.exe,” select the default complete setup and destination folder, and 
follow the installation instructions.  Note: Running this setup file (which for convenience 
the researchers downloaded from the vendor’s web site to the UACT DVD) will install an 
evaluation version of the software.  For a full implementation of UACT, TxDOT will 
need to acquire a license directly from the software vendor. 
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Use the following procedure to configure Adlib Express Server: 
 

• Start Express Server as an application by selecting Start > All Programs > Adlib > 
Express > Express Server (Figure 20). 

 

 

Figure 20.  Express Server Window. 

 
• If Express Server is already running as an application, click “Stop Monitoring.”  
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• If Adlib Express Server is already running as a service, stop the Adlib Express Server 
service and then start Express Server as an application in order to change Adlib Express 
options.  To stop the Adlib Express Server service: 

 
o On the Windows Taskbar select Start > Run, then type “services.msc” and click 

“OK”; 
 

o in the Services console, select Adlib Express Server and click the “Stop” button 
(Figure 21); and 

 
o start Express Server as an application by selecting Start > All Programs > Adlib > 

Express > Express Server.  
 

 

Figure 21.  Services Console Window Showing the Adlib Express Server Service. 

 
• From the Tools menu (Figure 20), select Application Settings. 
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• Select the following options (Figure 22): 
 

o Enable Adlib FMR 
o Enable Restart after — 250 documents 
o Enable Inactivity Timeout — 600 seconds 
o Enable Job Timeout — 1000 seconds 
o Maximum number of Retries:  3 

 

 

Figure 22.  Application Settings Window. 
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• Click “Options” (Figure 20) to modify Express Server options (Figure 23). 
 

 

Figure 23.  Express Server Folder Options Window. 

 
• On the Folders tab, change the default folder names as follows (Figure 23): 

 
o Input Folder:   D:\FILE_UPLOAD\dpiInput-bin 
o Destination Folder: D:\FILE_UPLOAD\dpiOutput-bin  
o Output Folder:  D:\FILE_UPLOAD\pdfOutput-bin 
o Error Folder:   D:\FILE_UPLOAD\error-bin 
o Work Folder:   C:\Adlib Express\Work (default folder) 

 
Note: Adlib Express creates default input, output, error, and work folders.  For UACT, it 
is necessary to select the folders above (created after copying the UACT folder from the 
UACT DVD—see instructions under “Folder Structure and Code Copying” earlier in this 
chapter). 

 
• Under Input File Handling, select Move File to Destination Folder. 
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• Check Enable Logging and click the “…” button underneath.  The Log Settings window 
appears (Figure 24).  In the Log Settings window, select the following settings: 

 
o Retention period: 14 days 
o Enable Document Log 
o Retain Process Log History (if you would like to debug Adlib Express) 
o Compress Process Log History to Zip (if you would like to debug Adlib Express) 
o Retain Document Log History (if you would like to debug Adlib Express) 

 

 

Figure 24.  Log Settings Window. 
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• On the Processing tab (Figure 25), select the following settings: 
 

o Check Input Folder Every 5 seconds 
o Enable DPI/XML Job Ticket Processing 
o Move File to Destination Folder option under Job Ticket File Handling 
o Cancel DPI Job Ticket Processing on Conversion Error 
o Cancel DPI Job Ticket Processing on Missing Document Input 
o Cancel DPI Job Ticket on PDF Security 

 

 

Figure 25.  Express Server Processing Settings Window. 
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• On the Outputs tab (Figure 26), click the “…” button under Convert to PDF Format.  
 

 

Figure 26.  Express Server Outputs Settings Window. 
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• The Information Settings screen appears (Figure 27).  In this screen, select the following 
settings, then click “OK”: 

 
o Move File to Output Folder under File Handling 
o filename.ext.pdf under File Naming 
o Preserve File Extension 
o Preserve Last Modified Date 

 

 

Figure 27.  Convert to PDF Settings Window. 
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• Click the “…” button under Convert to PDF Information Format in the Express Server 
Options window (Figure 26).  The Convert to PDF Information Settings screen appears 
(Figure 28).  On this screen, do the following: 

 
o Select the following options under PDF Information Type:  

 
 Text 
 File 
 Pages 
 Bookmarks 

 
o Select the following options under PDF Information Options:  

 
 Format:   CSV 
 Encoding:   ISO88591 
 CSV Delimiter:  , 
 CSV Headings:  No 
 Text Style:   Default 

 

 

Figure 28.  Convert to PDF Information Settings Window. 
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• On the PDF Options tab (Figure 29), select the following settings: 
 

o PDF Version: 1.3 
o PDF Type: PDF 
o Font Embedding 
o Enable PDF Security 
o Enable PDF Open Settings 

 

 

Figure 29.  Express Server PDF Options Settings Window. 
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• On the PDF Options tab of the Express Server Options window, click the “…” button 
under PDF Options (Figure 29).  The PDF Compression Options screen appears (Figure 
30).  Select the following settings and click “OK”: 

 
o Optimize for Fast Web View 
o Page Content Compression 
o Resolution: 300 dpi 
o Color Image Compression: Automatic 
o Compression Level: Maximum 
o Monochrome Image Compression: CCITT Group 4 

 

 

Figure 30.  PDF Compression Options Window. 
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• On the PDF Options tab of the Express Server Options window, click the “…” button 
under Bookmarks, Hyperlinks, and Table of Contents Settings (Figure 29).  The 
Bookmarks, Hyperlinks, and Table of Contents Settings window appears (Figure 31).  
Select the following settings and click “OK”: 

 
o Enable Bookmarks 
o Do not select (or unselect) Enable Hyperlinks 

 

 

Figure 31.  Bookmarks, Hyperlinks, and Table of Contents Settings Window. 

 
• On the PDF Options tab of the Express Server Options window, click the “…” button 

under Font Embedding (Figure 29).  The Font Embedding Options window appears 
(Figure 32).  Select the following settings and click “OK:” 

 
o Embed Partial Fonts 
o Embed Standard Fonts 
o Embed Licensed Fonts 
o Multi-Language Support 

 

 

Figure 32.  Font Embedding Options Window. 
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• On the PDF Options tab of the Express Server Options window, click the “…” button 

under Enable PDF Security (Figure 29).  The PDF Security Settings window appears 
(Figure 33).  Select the following settings and click “OK”: 

 
o Encryption: 40 Bit Encryption – Acrobat 3+ 
o Do not select (or unselect) Printing 
o Changing the Document 
o Selecting Text and Graphics 
o Do not select (or unselect) Adding or Changing Annotations and Form Fields 

 

 

Figure 33.  PDF Security Settings Window. 
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• On the PDF Options tab of the Express Server Options window, click the “…” button 
under Transformation (Figure 29).  The Transformation window appears (Figure 34).  
Select the following settings and click “OK”: 

 
o Do not select (or unselect) Enable Page Scaling 
o Enable Page Content Scaling 
o Scale by Margin (inches): 0.25 (all margins) 
o Page Content Alignment: Center-Center  

 

 

Figure 34.  Transformation Settings Window. 
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• On the PDF Options tab of the Express Server Options window, click the “…” button 
under Enable PDF Open Settings (Figure 29).  The PDF Open Settings window appears 
(Figure 35).  Select the following settings and click “OK”: 

 
o Page Mode: Bookmarks and Page 
o Magnification: Default 
o Page Number: 1 
o Page Layout: Single Page 
o Only Display Bookmark Panel if Bookmarks Exist 

 

 

Figure 35.  PDF Open Settings Window. 

 
• Select the Document Options tab on the Express Server Options window (Figure 36): 

 

 

Figure 36.  Express Server Document Options Window. 
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• Click the “…” button under Computer Aided Design (CAD) Settings.  The Computer 

Aided Design (CAD) Settings window appears (Figure 37).  Select the following settings 
and click “OK”: 

 
o Convert HPGL Using Native Application 
o Portrait Page Size: Tabloid 
o Landscape Page Size: Tabloid 
o Margin (inches): 0.25 (both vertical and horizontal) 

 

 

Figure 37.  Computer Aided Design Settings Window. 
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• On the Document Options tab in the Express Server Options window, click the “…” 
button under HTML Settings (Figure 36).  The HTML Settings window appears (Figure 
38).  Select the following settings and click “OK”: 

 
o Orientation: Portrait 
o Size: Letter 
o Margins (inches): 0.25 (all margins) 

 

 

Figure 38.  HTML Settings Window. 
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• On the Document Options tab in the Express Server Options window, click the “…” 
button under Text Settings (Figure 36).  The Text Settings window appears (Figure 39).  
Select the following settings and click “OK”: 

 
o Font Name: Courier New 
o Font Style: Regular 
o Enable Page Layout Settings 
o Orientation: Portrait 
o Page size: Letter 
o Font Size: 7 
o Margins (inches): 0.25 (both vertical and horizontal) 

 

 

Figure 39.  Text Settings Window. 
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• When finished with the settings, click “OK” on the Express Server Options window to 
save the changes and go back to the main interface (Figure 40). 

 

 

Figure 40.  Express Server Main Interface Window. 

 
• To run Express Server as an application, click “Start Monitoring.”   

 
o If Express Server will be used as a service and it stops working (making it 

necessary to restart the service), first run Express Server as an application to clear 
all pending PDF conversion jobs in the folder 
E:\UACT\FILE_UPLOAD\dpiInput-bin. 

 
o Under normal operation conditions, it is not advisable to run Express Server as an 

application in an environment where it may be necessary to convert hundreds of 
files to PDF.  Although Express Server has an option to restart automatically after 
processing a predetermined number of files (which the vendor recommends), that 
option tends to fail often when running Express Server as an application. 
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• To create an Adlib Express Server service, perform the following steps: 
 

o Open the Command Prompt console by selecting Start > Run, then type “cmd” 
and click “OK.”  The command prompt window opens. 

 
o Enter the following command line (the Adlib Express Server service will be 

created, but it is not running yet) (Figure 41): 
 

C:\”Program Files”\Adlib\Express\adexps.exe /INSTALL_SERVICE 
 

 

Figure 41.  Install Adlib Service Window. 
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• To configure the Adlib Express Server service, perform the following steps: 
 

o On the Windows task bar, select Start > Run, then type “services.msc” and click 
“OK”; and 

 
o on the Services console (Figure 42), right-click “Adlib Express Server” and select 

Properties to open the Adlib Express Server Properties window (Figure 43). 
 

 

Figure 42.  Adlib Express Server Service Properties Window. 
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o Select the Log On tab in the properties window and configure the service to run 
with an administrator account (Figure 43). 

 

 

Figure 43.  Log On Tab of the Adlib Express Server Properties Window. 
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o On the Services console (Figure 42), right-click “Adlib FMR” and select 
Properties to open the Adlib FMR (Fault Monitoring and Recovery) Properties 
window (Figure 44). 

 

 

Figure 44.  Adlib FMR Properties Window. 
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• To configure Distributed Component Object Model (DCOM) permissions (whether 
running Express Server as an application or as a service), do the following: 

 
o On the Windows task bar, select Start > Run, then type “dcomcnfg” and click 

“OK.”  The Component Services window appears (Figure 45). 
 

 

Figure 45.  DCOM Config Folder in the Component Services Window. 

 
o In the Component Services window, expand the Component Services folder until 

the DCOM Config folder appears.  Expand the DCOM Config folder. 
 

o The following DCOM objects belong to applications that Express Server uses in 
the PDF conversion process: 

 
 AdConv.AdConvNS 
 AdlibPDF.PDFBookmark 
 AutoVue.Application 
 Microsoft Word 
 Microsoft Excel 
 Microsoft PowerPoint  
 Microsoft Visio  
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o For each of these DCOM objects, complete the following steps: 
 

 Right-click the object and select Properties to open the Properties window 
(Figure 46). 

 

 

Figure 46.  AdConv.AdConvNS Properties Window. 
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 In the Properties window (Figure 46), select the Security tab. 
 

 Under Launch and Activation Permissions in Figure 46, select Customize 
and click “Edit” to show the Launch Permission window (Figure 47). 

 

 

Figure 47.  Launch Permission Window. 

 
 Make sure the account that is running the Express Server service is 

included in the list of permissible users. 
 
 Click “OK” to close the Launch Permission window. 
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 Under Access Permissions in Figure 46, select Customize and click “Edit” 
to show the Access Permission window (Figure 48). 

 

 

Figure 48.  Access Permission Window. 
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 Make sure the account that is running the Express Server service is 
included in the list of permissible users. 

 
 Click “OK” to close the Access Permission window. 

 
• Configure Data Execution Prevention (DEP) to ensure that Windows allows the Express 

Server and Adlib FMR executables to run, as follows: 
 

o On the windows task bar, select Start > Run, then type “sysdm.cpl” and click 
“OK” to open the System Properties window (Figure 49). 

 

 

Figure 49.  System Properties Window. 

 
o Select the Advanced tab.  Under Performance, click “Settings.” 
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o Select the Data Execution Prevention tab and select the Turn on DEP for all 
programs and services except those I select: option (Figure 50). 

 

 

Figure 50.  Performance Options: Data Execution Prevention Setting Tab. 

 
o Click the “Add” button and navigate to C:\Program Files\Adlib\Express.  Select 

adexps.exe and click “OK.” 
 

o Repeat the last step to add the “AdlibFMR.exe” file.  
 

o Click “OK” several times until exiting the properties window. 
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• To configure Adlib Express Server to run as a service automatically, use the following 
procedure: 

 
o On the Windows task bar, select Start > Run, then type “services.msc” and click 

“OK” to display the Services console (Figure 51). 
 

 

Figure 51.  Services Console. 
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o On the Services console, right-click “Adlib Express Server” and select Properties 
(Figure 52). 

 
o On the General tab, select the startup type Automatic and click “OK.” 

 

 

Figure 52.  General Tab of the Adlib Express Server Properties Window. 

 
o Close the Services console. 

 
o Close any open applications and reboot the server.  Adlib Express Server will start 

up automatically after rebooting the server. 
 
 

ESRI ARCGIS SERVER V9.2 INSTALLATION 

This programmer guide assumes that ESRI ArcGIS Server version 9.2 has been installed on an 
implementation server that will be available for the UACT application.  This programmer guide 
will not provide guidance on the installation of ESRI ArcGIS Server.  However, in the following 
section, the programmer guide provides systematic instructions for the configuration of the 
ArcGIS Server mapping component. 
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UACT MAPPING COMPONENT CONFIGURATION 

This section provides instructions on the configuration of the UACT mapping component that 
displays GIS data including aerial photography, route network, utility installations, and utility 
conflict outlines.  The mapping component configuration includes the generation of a new GIS 
Administrator account, creation of a new map service, and creation of a new map application. 
 

Create A New ArcGIS Server Administrator 

The installation of ArcGIS Server should instruct the installer to create a new GIS Server 
Administrator account in the agsadmin system user group.  If the account does not exist, create a 
new account as follows: 
 

• Go to Start > All Programs > Administrative Tools > Computer Management. 
 
• Double-click on “System Tools.” 

 
• Double-click on “Local Users and Groups.” 
 
• Click on “Users.” 
 
• In the Computer Management menu bar, select Action > New User and provide the 

required information. 
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Now the user can be added to the groups of GIS server administrators on the map server, as 
follows: 
 

• Go to Start > All Programs > Administrative Tools > Computer Management. 
 
• Double-click on “System Tools.” 
 
• Double-click on “Local Users and Groups.” 
 
• Click on “Groups.” 
 
• Double-click on “agsadmin.” 
 
• Click on “Add,” enter the GIS server administrator account name, and click “OK” 

(Figure 53). 
 

 

Figure 53.  GIS Administrators Properties Window. 
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Next, add the GIS server administrator account to the group of server administrators, as follows: 
 

• Go to Start > All Programs > Administrative Tools > Computer Management. 
 
• Double-click on “System Tools.” 

 
• Double-click on “Local Users and Groups.” 

 
• Click on “Groups.” 

 
• Double-click on “Administrators.” 

 
• Click on “Add,” enter the GIS server administrator account name, and click “OK” 

(Figure 54). 
 

 

Figure 54.  Server Administrators Properties Window. 

You now have sufficient permission to login to ArcGIS Server Manager and create a new Map 
Service. 
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Create a New Map Service 

To create a new map service, follow these steps: 
 

• Go to Start > All Programs > ArcGIS > ArcGIS Server for the Microsoft .NET 
Framework > ArcGIS Server Manager. 

 
• A browser window should open a login page similar to the page shown in Figure 55: 

 

 

Figure 55.  ArcGIS Server Manager Login Page. 
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• Log into ArcGIS Server Manager by providing the username and password and clicking 
on “Log In.” 

 
• Select the Services tab at the top of the page (Figure 56). 

 
• Select a folder on the left-hand side under Folders, or create a new folder by clicking on 

“Add” under Folders. 
 

• Click on the “Add New Service” link. 
 

 

Figure 56.  ArcGIS Server Manager, Services Tab. 
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• Enter “UACT_MapService” in the Name box of the Add New Service screen (Figure 57). 
 

• Select Type: Map Service. 
 

• Provide a description if desired. 
 

• Select Startup Type: Automatic, and click “Next.” 
 

 

Figure 57.  ArcGIS Server Manager, Add New Service, Step 1. 
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• Under Map Document, browse to the location of the UACT ArcMap document to be used 
by the map (Figure 58).  This should be located at d:\UACT\GIS\ArcMapDocument\. 

 
• Under Output Directory, enter the following: 

 
d:\arcgisserver\arcgisoutput 

 
• Under Server Cache Directory, enter the following 

 
d:\arcgisserver\arcgiscache 

 
• Click “Next.” 
 

 

Figure 58.  ArcGIS Server Manager, Add New Service, Step 2. 
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• On the following screen, use the default settings as shown in Figure 59, and click “Next.” 
 

 

Figure 59.  ArcGIS Server Manager, Add New Service, Step 3. 
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• On the following screen, use the default settings shown in Figure 60, and click “Save.” 
 

 

Figure 60.  ArcGIS Server Manager, Add New Service, Step 4. 
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• ArcGIS Server Manager should return to the Services tab, as shown in Figure 61. 
 

 

Figure 61.  ArcGIS Server Manager, Add New Service, Step 5. 
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To start the new service, do the following: 
 

• Check the checkbox next to the new map service and click “Start” (Figure 62). 
 

 

Figure 62.  ArcGIS Server Manager: Start New UACT Map Service. 

 
• The map service is now started.  If you want to edit or modify any settings of the map 

service, click the pencil icon in the Edit column of the map service’s row. 
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Create A New Map Application 

Now we can proceed to create a map application that uses the new map service, as follows: 
 

• Select the Applications tab on the top menu. 
 
• Click on “Create Web Application” link (Figure 63). 

 

 

Figure 63.  ArcGIS Server Manager, Applications Tab. 
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• The Web Application screen should appear (see Figure 64). 
 

• Enter the applicable host name under Host. 
 

• Enter “UACT_MapApp” in the Name box and click “Next.” 
 

 

Figure 64.  ArcGIS Server Manager, Create New Web Application: Specify Name and 
Host. 
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• Under Available Services, expand ArcGIS Server Local node and select 
UACT_MapService. 

 
• Click “Add” to select the map service to the map application (Figure 65). 

 
• Click “Next.” 
 

 

Figure 65.  ArcGIS Server Manager, Create New Web Application: Select Map Service. 
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• On the following screen, select Editing, and click “Add” (Figure 66). 
 

 

Figure 66.  ArcGIS Server Manager, Create New Web Application: Select Tasks. 
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• Click “Configure,” and under the General tab check the checkbox next to Utility Conflict 
Outline (Figure 67). 

 

 

Figure 67.  ArcGIS Server Manager, Create New Web Application: Configure General 
Preferences of Task. 
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• Under the Settings tab, under Snapping Rules, check Vertex, Edge, and End for the Utility 
Conflict Outline layer (Figure 68). 

 

 

Figure 68.  ArcGIS Server Manager, Create New Web Application: Configure Settings 
Preferences of Task. 

 
• Do not change the other default settings. 

 
• Click “OK” to leave the Task Configuration window. 
 
• Click “Next.” 
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• On the ArcGIS Server Local Connections screen, make sure the user name shown in the 
textbox belongs to the server administrators and agsadmin group on the map server (see 
section Create A New ArcGIS Server Administrator at the beginning of this chapter) 
(Figure 69). 

 
• Click “Next.” 

 

 

Figure 69.  ArcGIS Server Manager, Create New Web Application: Verify Local 
Connection User Name. 
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• On the Set Page Properties screen, enter “UACT Map Application” in the Title text box 
(Figure 70). 

 
• Click “Next.” 

 

 

Figure 70.  ArcGIS Server Manager, Create New Web Application: Set Page Properties. 
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• Click the “Settings” button next to Overview Map and check Show when web application 
starts (Figure 71). 

 
• Click “OK.” 
 
• Click “Finish.” 
 

 

Figure 71.  ArcGIS Server Manager, Create New Web Application: Overview Map Settings 
Window. 

 
This completes the creation of the GIS map application.  UACT will now be able to use this map 
application to view utility and project data. 
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MICROSOFT IIS FINAL CONFIGURATION 

This section summarizes the steps to configure IIS to enable the UACT web site.  Use the 
following procedure to configure the UACT web site created earlier in the installation process: 

 
• Open IIS Manager: Navigate to Start > Control Panel > Performance and Maintenance > 

Administrative Tools, and click the “Internet Information Services” shortcut. 
 

• In the left panel of the IIS Manager, right-click on UACT web site (or virtual directory) 
and select Properties in the context menu.  The UACT Properties window appears 
(Figure 72). 

 

  

Figure 72.  UACT Properties Window. 
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• Click the “Configuration…” button on the Virtual Directory (or Home Directory) tab 
(Figure 73). 

  

 

Figure 73.  UACT Properties Window: Virtual Directory Tab. 
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• The Application Configuration window appears (Figure 74). 
 
• In the Application Configuration window, select the Options tab.  Under Application 

Configuration, set the following: 
 

o Session timeout: 60 minutes. 
o Check Enable buffering. 
o Check Enable parent paths. 
o ASP script timeout: 240 seconds.  
 

• Click “OK” to return to the Virtual Directory tab. 
 

 

Figure 74.  Application Configuration Window: Options Tab. 
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• Select the HTTP Headers tab (Figure 75). 
 

• Check the Enable content expiration checkbox. 
 
• Under Web site content should, select the Expire immediately radio button. 

 

 

Figure 75.  UACT Properties Window: HTTP Headers Tab. 
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• Click the “MIME Types…” button.  The MIME Types window appears (Figure 76). 
 

 

Figure 76.  MIME Types Window. 

 
• In the MIME Types window, click the “New” button.  A new MIME Type window opens 

(Figure 77). 
 
• Type “dgn” for Extension and “dgn” for MIME type. 
 
• Click “OK.”  
 

 

Figure 77.  New MIME Type Window. 
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• Repeat the previous steps to create a new MIME Type for the “dwg” extension: Click the 
“New” button, then enter “dwg” for Extension and “dwg” for MIME type.  Click “OK.”  
Both .dgn and .dwg MIME types (file extensions) are now registered and should appear 
in the MIME Types window (Figure 78). 

 

 

Figure 78.  MIME Types Window: New MIME Type. 

 
• Click “OK” to complete the creation of the new MIME types. 
 
• Click “OK” again to close the UACT Properties window. 
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• In the left panel of the IIS Manager, click “Web Service Extensions” (Figure 79). 
 

 

Figure 79.  IIS Manager Window: Web Service Extensions. 

 
• Make sure that the status of the following two extensions is “Allowed”:  
 

o ASP.NET v2.0, and 
o Server Side Includes. 
 

• If the status of any of these three extensions is “Prohibited,” click the service name, then 
click the “Allow” button to change its status to “Allowed.” 

 
• Close the window after completing this step. 
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• Using Windows Explorer, expand the UACT folder, right-click the “File_Upload” folder, 
and select Properties to open the Properties window (Figure 80). 

 

 

Figure 80.  UACT-UserFiles Folder: Properties Window. 
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• In the Properties window, select the Security tab (Figure 81). 
 

 

Figure 81.  UACT-UserFiles Folder: Security Tab. 

 
• Make sure that Users under Group or user names have read and write permissions, and 

that Administrators have full control permission. 
 
• Click “OK” to apply the settings. 

 

ESRI ARCSDE CONFIGURATION 

This section of the installation guide provides guidance on the configuration of ArcSDE.  This 
installation guide assumes that ArcSDE and ArcCatalog have been installed previously.  The 
UACT prototype installed ArcSDE on a server called gim-oracle.  The installer should make 
changes according to the name of the local server used for the installation of ArcSDE.  This 
guide will cover the following activities: 
 

• Creating a new database connection. 
 
• Importing the Utility_Conflict_Outline feature class into ArcSDE. 
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Create a New ArcSDE Database Connection 

To create a new database connection, follow these steps: 
 

• Open ArcCatalog and expand the Database Connections node (Figure 82). 
 

• Click on “Add Spatial Database Connection.” 
 

 

Figure 82.  ArcCatalog, Database Connections Window. 
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• In the Spatial Database Connection window, enter your server name in the Server box 
(Figure 83). 

 
• Enter “port:5151” for Service and your database service name in the Database box. 
 
• Enter username and password of the user account used when installing ArcSDE. 

 
• Click “Test Connection.” 

 
• You should see “Connection succeeded” message.  If not, check server name, database 

service name, and user account again. 
 

• If the connection was created successfully, click “OK” in the message box and click 
“OK” again. 

 

 

Figure 83.  Spatial Database Connection Window. 
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• The Database Connection window should show the new connection to the spatial 
database (Figure 84). 

 

 

Figure 84.  New Database Connection in Database Connection Window. 

 

Importing the Utility Conflict Outline Feature Class into ArcSDE 

To import an existing feature class layer into ArcSDE, follow these steps: 
 

• Right-click on “Connection to <your spatial database server>.” 
 
• Select Import > Feature Class (Single). 
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• The Feature Class to Feature Class window opens (Figure 85). 
 

 

Figure 85.  Feature Class to Feature Class Window. 

• Under Input Features, click the “Browse” button and browse to Utility_Conflict_Outline 
feature class located at 

 
d:\UACT\GIS\Geodatabase\ConflictGDB.mdb\Utility_Conflict_Outline 

 
• Do not change the default under Output Location. 
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• Enter a name for Output Feature Class: “Utility_Conflict_outline” (Figure 86). 
 

 

Figure 86.  Feature Class to Feature Class Window, Output Feature Class. 

 
• Click “OK.” 
 
• Click “Close” in the following dialog box (Figure 87). 

 

 

Figure 87.  Feature Class to Feature Class Dialog Box. 
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• In the Database Connection window, double-click on “Connection to < Your spatial 
database server>.”  You should see a list of feature classes on your ArcSDE server, 
including the “Utility_Conflict_outline” feature class you just uploaded (Figure 88). 

 

 

Figure 88.  New Feature Class in Database Connection Window. 

 
• The feature class Utility_Conflict_Outline will be used by the ArcMap document, which 

in turn ArcGIS Server map service uses to display outlines of utility conflicts. 
 
• This completes the configuration of ArcSDE. 
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CHAPTER 4.  COPYING DATA AND VERIFICATION OF UACT SETUP 

INTRODUCTION 

This chapter describes the steps to copy data to the Oracle database.  The dataset includes seed 
data and utility installation request data from the TTI UACT prototype implementation.  This 
chapter provides guidance for the following activities: 
 

• configuration of the Oracle database and 
 
• copying of UACT data to the Oracle database. 

 

CONFIGURATION OF THE ORACLE DATABASE 

Use the following procedure to configure the Oracle database, which involves creating an Oracle 
tablespace and an Oracle user account for UACT. 
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Create a Tablespace for UACT on the Oracle Server 

• On the Oracle Server, click “Administration” menu (Figure 89). 
 
• Under Storage column, click Tablespaces then click on “Create” button on the far right.   

 

 

Figure 89.  Oracle Enterprise Manager Screen: Administration Tab. 
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• The Create Tablespace window appears (Figure 90). 
 

• Enter “UACT” for Name. 
 
• Click on “Add” button to add datafile (Figure 90).   

 

 

Figure 90.  Oracle Create Tablespace Window. 
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• The Add Datafile window opens (Figure 91). 
 

• Click a “Continue” button. 
 

 

Figure 91.  Oracle Enterprise Manager: Add Datafile to Tablespace. 
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• On the Create Tablespace page, click the “OK” button on the bottom right of the screen 
(Figure 92). 

 

 

Figure 92.  Oracle Create Tablespace Window with New Tablespace. 
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• To create user accounts for UACT in Oracle, select Users in the Users and Privileges 
group (Figure 93). 

 

 

Figure 93.  Oracle Administration Window. 
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• In the Create User window, click the “Create” button and enter information for the 
UACT_USER account, as shown in Figure 94. 

 
• Make sure to select UACT as the default tablespace for the UACT_USER account. 
 
• Click the “Roles” menu, then click on “Edit List” button (Figure 94). 

 

 

Figure 94.  Oracle Create User Window. 
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• From the list of available roles, select Resources and then click “Move” (Figure 95). 
 

• Make sure that Connect is also listed under Selected Roles. 
 
• Click “OK,” then click “OK” again. 

 

 

Figure 95.  Oracle Modify Roles Window. 
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• Repeat the previous steps to create additional tablespaces and user accounts as shown in  
Table 1: 

 

Table 1.  UACT Tablespace Size Requirements. 

Tablespace Name User Account Minimum 
Tablespace Size Datafile Name 

FileNet FileNet_User 20 MB FileNet_Data.dbf 

MainStreet MainStreet_User 20 MB MainStreet_Data.dbf 

ROWIS Rowis_User 20 MB Rowis_Data.dbf 

SDE Sde 20 MB SDE_Data.dbf 

UACT UACT_Owner 100 MB Uact_Data.dbf 

UFD UFD_User 30 MB UFD_Data.dbf 

UIRPRO UIRPRO_User 200 MB UIRPRO_Data.dbf 

DCIS DCIS_User 20 MB DCIS_Data.dbf 
 

COPYING UACT DATA TO THE ORACLE DATABASE 

The installation DVD contains the following Oracle export files: 
 

• Uactdev_owner_8_5_2008.dmp.  This file contains the UACT schema including most 
database objects such as tables, views, functions, synonyms, and data.  Import this 
schema from UACTDev_owner to UACT_Owner. 

 
• Uactdev_user_8_5_2008.dmp.  This file contains synonyms of database objects in the 

schema listed above.  The synonyms allow the web application to use resources in other 
schemas.  Import this schema from UACTDev_user to UACT_USER. 

 
• FileNet_user_8_31_2008.dmp.  This file contains the FileNet_User schema. 
   
• MainStreet_8_5_2008.dmp.  This file contains the MAINSTREET schema including 

core tables of the MainStreet Texas implementation. 
 
• Rowis_user_8_31_2008.dmp.  This file contains the Rowis_User schema. 

 
• Sde_8_31_2008.dmp.  This file contains the SDE schema. 

 
• UFD_user_8_5_2008.dmp.  This file contains the UFD schema including the database 

objects and data of spatial utility features. 
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• uir20071227.zip.  This file contains the UIRPRO schema.  Unzip it before importing the 
schema. 

 
• DCIS_8_5_2008.dmp.  This file contains the DCIS schema including the DCIS DATA 

WAREHOUSE table and sample DCIS data. 
 
After creating all tablespaces and user accounts listed above, import data from the dump files to 
the Oracle database.  It is advisable to copy the whole content of UACT DVD to a local hard 
drive of the Oracle database server before proceeding. 
 

• Open a command prompt by going to Start > Run > and typing “cmd.” 
 
• Navigate to the folder D:\Data. 

 
• Import file Uactdev_owner_8_5_2008.dmp using the following option (Figure 96): 

 
FromUser=UactDev_Owner ToUser=Uact_Owner 

 

 

Figure 96.  Command for Importing Dump File Uactdev_Owner. 

 
• Import file uactdev_user_8_5_2008.dmp using the following option (Figure 97): 
 

FromUser=UactDev_User ToUser=Uact_User  
 

 

Figure 97.  Command for Importing Dump File Uactdev_User. 
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• Import FileNet_user_8_31_2008.dmp files without options (Figure 98). 
 

 

Figure 98.  Command for Importing Dump File FileNet_User. 

• Repeat the above steps to import data for all other schemas without options. 
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CHAPTER 5.  UACT INSTALLATION TESTING AND PERFORMANCE 

 

UACT INSTALLATION TESTING 

Use the following brief procedure to verify that UACT is working properly (refer to the UACT 
User Manual for more help on each step): 
 

• Open a new Internet Explorer window, preferably on a different machine than the web 
server where UACT resides.  Type in the URL address for UACT. 

 
• Login to UACT using one of the existing dummy accounts to login (username and 

password provided separately). 
 

• Create a new project by importing dummy DCIS data. 
 

• Click on the new project in the home screen to log into the new project. 
 

• Import a few utility facilities using dummy UFD data. 
 

• Create a new utility conflict.  Creating utility conflicts requires several steps that the user 
manual describes in detail.  Refer to the user manual for more information on how to 
create utility conflicts (7). 

 
• After the utility conflict is complete, edit the utility conflict outline using the mapping 

component. 
 

• Create a new utility agreement assembly for the utility conflict created previously.  
Creating utility agreement assemblies requires several steps that the user manual 
describes in detail.  Refer to the user manual for more information on how to create 
utility agreement assemblies (7). 

 
• Create additional utility conflicts, and change the status of each conflict under the edit 

utility conflict option. 
 

• Go to the reports page to verify that the report “create utility conflict certification” is 
working. 

 
The previous steps presented a brief and quick procedure to verify that the UACT installation is 
successful.  Before UACT becomes fully operational, the researchers recommend testing the 
prototype during an implementation project with one or more testing districts. 
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